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How to use 
1   Order licences

2   Install ExamWizard

3   Run from desktop icon or start menu

MARK ENTRY SHEET

Opens in Excel detailing questions 
in your document and space to 
enter marks. Import or create 
student lists.

QUESTION FINDER

Question Finder 
contains
indexed items. 

Search by Topic, 
Level, Type, 
Speci� cation 
reference or Paper/Unit. 

Click on  to see the list of 
available categories. 

Click  to view sub-topics.

Start search to begin  

Continue search to
combine categories  

PRINTING AND EDITING

Copy the items you want
into the New document

Print preview

Print

Get mark scheme

Get examiner’s report

Edit document in Word

reference or Paper/Unit

VIEWER WINDOW

The Viewer displays the question 
highlighted in the Question Finder. 
See all the related material by 
clicking on the buttons
(if highlighted) :

Mark scheme

Commentary from
examiners’ reports

Link to speci� cation

Resources/related text 

Additional notes

Browse through
your selection  

The back button
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To create an assessment and mark scheme

1 Click here to see the topic list   

2 Click here to select level             

3 View selected items in the Viewer

4 Copy items you want into
an untitled document

5
Insert title,
if required from
insert drop-
down menu

6 Print preview (to change 
sequence, drag & drop)

7 Click here for mark scheme

8 Click here for commentary

Edit your document 
in Word to adapt 
or add your own 
materials, or 
highlight text etc.

Import from existing database
or create a new class list to
record marks

Generate spreadsheet in Excel 
itemising selected questions, 
enabling mark entry and basic 
calculations (eg total marks, % 
and averages)

Examiners’ comments 
provide information 
on errors and 
misconceptions that 
can inform teaching 
and learning

 
Answers and 
guidance on 
marking

tools drop-down menu
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The Power of ExamWizard
ExamWizard provides you with a bank of questions that can be used in a variety of ways to 
support your teaching of examination subjects.

Teachers in schools and colleges use ExamWizard to produce: 

• end of topic or unit tests; 
• targeted practice materials at diff erent levels; 
• mock examinations; 
• mark entry sheets for collating scores on customised tests; 
• documents containing an original question, its mark scheme and examiner’s report; 
• worksheets edited from original examination questions.

All at a few clicks of the mouse and in the space of a few minutes.

Generate mark schemes and examiners’ reports from your question compilations that enable 
you to mark and evaluate student performances [See below]. 

user guide

Introduction

ExamWizard provides teachers 
with past examination questions, 
their mark schemes and examiners’ 
reports to support the teaching of 
GCSE and AS/A2 across a range of 
subjects. All questions are indexed 
by generic teaching topics for 
fl exibility and each question is 
linked to the appropriate and most 
up-to-date specifi cations. If you 
have not used ExamWizard before, 
please see the Quick Guide above to 
get you started. The User Guide will 
provide you with guidance on how 
to get the most from ExamWizard.

Example: ExamWizard  Edexcel GCSE Mathematics Screen
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Get Started
When you open ExamWizard it displays three separate windows. The large window on the right-hand side 
that occupies the majority of the screen is the Viewer; when you select a question it will be displayed in the 
Viewer. The Question Finder is to the left and contains details of every question, allowing you to search for 
specifi c questions that fi t your requirements. Below the Question Finder is an empty document (by default 
this will be called ‘New Document’). Anything you want to print must fi rst be copied into that document.

Question Finder - How to search for material
The top left window is the Question Finder.

In the Question Finder you will fi nd the 
search categories and the list of all the 
questions/items included in the database.

Example: ExamWizard  Edexcel GCSE Biology Screen

Search

Use the search indexes to help you locate suitable material for creating your tests or homeworks.

To view all the search categories, click on the square box ( 

Use the search indexes to help you locate suitable material for creating your tests or homeworks.

To view all the search categories, click on the square box (  ) to the right of each search fi eld.
This allows you to search through all the questions that have been selected for this database. 
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You can search by categories such as level, topic, year, etc. These categories may vary for each subject; the 
Teacher Guidance introduction screen in ExamWizard details the categories available and shows how each 
one is broken down. Sometimes categories are grouped under main headings with a small red cross. If you 
double-click on the cross then you will be able to see the complete list of search categories.

Topics are listed hierarchically by default but can also be
listed alphabetically by simply clicking on the ABC button listed alphabetically by simply clicking on the ABC button  .

 
You can search by one of the categories by

 clicking Start Search. This will display every
 question indexed to this category in the
 Question Finder. 

 
 To narrow your search, select a new category,

 in a diff erent fi eld, and this time click
 Continue Search. 

 
 

 To start a new search, select a diff erent
 category and click Start Search. 

 
  

(SEE APPENDIX 1)
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Questions

In the Question Finder you will fi nd the list of all of the questions/items included in the database and 
descriptors to help you identify them.

Marks

Time allowed

TopicTopic

Type - Structured Question 

Brief description

Type - Structured Question

A00 - Spec A Year 2000 
B1 - Unit B1
01 - Question 01

Brief description

Level - Foundation

Viewer - Review questions and related text
When you select a question in the Question Finder or in the New Document, this will appear in the Viewer for 
review. The buttons at the top of this window take you to the related:

  Links to relevant specifi cation(s)

  Mark scheme

  Examiner’s report

  Resources/related text  

  Additional notes

The buttons are highlighted when any text related to the selected question is available. When you click on 
the related mark scheme or examiner’s report, if the button is still highlighted more text is available for the 
entire section or paper the question is taken from. 

  To go back to the question

You can also use the following navigational buttons:

      Browse through your selection (up/down)

  Back
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New Document - Creating, preparing and printing 
The bottom left window contains a blank document. By default the document will be called New Document, 
but once you have created an assessment you can rename it by choosing ‘Save as’ from the File drop-down 
menu. You can then save it to your computer or network, allowing you to return to it at a later date if you 
wish to reuse or modify the assessment.

Anything you want to print must fi rst be copied into the document window. Click on the Copy to document  
button to copy selected questions into your document or drag and drop from the Question Finder (or press 
CTRL+D). Questions are automatically numbered and formatted before printing. Use the following buttons:

  To copy to document

  To save your document

  To print preview

  To print

  To export the document to Word – you can then  
 edit the document to adapt it, add your own   
 materials, highlight text etc. You can also do this
 by choosing ‘Export to Word’ from the Tools   
 drop-down menu.

  To create a New Document

Insert Title

You can insert a title for an assessment by choosing ‘Title’ from the Insert drop-down menu and entering
the details in the text entry box (pictured below).

You can also insert section titles to divide your assessment into sections. You can drag and drop the
section titles within the document window to modify the position of the section breaks if required.
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Creating Mock Examinations

You can select and print out complete past papers with their accompanying mark schemes and examiners’ 
reports on student performance to provide you with a complete mock examination: the paper, the answers 
and the interpretation. There are suffi  cient years to provide students with complete practice papers.

Example: Questions, GCSE Biology

Note: Please note that in some subjects complete questions have 
been divided into their component parts to cover a broader range 
of topics and to provide a useful bank of concise questions.

Assessing students’ abilities in dealing with particular types of question

Most questions involve a range of skills and knowledge that can be indexed as type categories in 
ExamWizard. The classifi cation of question types is not absolute and will diff er in each subject. 

Select the appropriate questions using the type index, copy them into a document, export to Word and edit 
them to highlight certain aspects or include your own comments.

Example: Types, GCE Physics (8/9PH01)

(SEE APPENDIX 2)
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Generating Mark Schemes / Examiners’ Reports
Once you have created a document with your selection of questions, you can create the corresponding
mark scheme and examiner’s report by clicking on the following buttons above the Question Finder:

  To create an automatic mark scheme for your   
 selection – provide answers and guidance on   
 marking. This can also be created by choosing   
 ‘Create Mark Scheme’ from the Tools drop-down  
 menu, or by pressing Ctrl+M.

  To create an automatic examiner’s report for your  
 selection – examiners’ reports provide    
 information on errors and misconceptions that can  
 inform teaching and learning. This can also
 be created by choosing ‘Create Report’ from the  
 Tools drop-down menu, or by pressing Ctrl+R.

Example: New document with related mark scheme and examiner’s report

The items in these documents will also be automatically numbered as the corresponding questions,
and they can be saved, edited and/or printed as any other document (see above).

You can also produce documents with a single question and its related mark scheme and examiner’s report 
to help students understand what the examiner is asking of them. Students can answer the question then 
self or peer review against the mark scheme and report. (SEE APPENDIX 3)

Related Text

  Click on the ‘Related text’ button to
 view all the mark schemes,   
 examiners’ reports, specifi cation  
 references and resources included  
 in the database. These can be  
 located in the tabs along the  
 bottom of the window.

 

 
Example: Related text, GCE Chemistry (8/9CH01)
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Create Index
If you want to keep a list of the questions you have selected and copied into your document, use the ‘Create 
Index’ feature in the Tools menu. This produces an Excel spreadsheet that lists the questions you have 
selected with the ExamWizard details: summary description, level, marks, topics, specifi cation reference.

Mark Entry Sheet - Record students’ marks
The ability to create a mark entry sheet for a selection of questions is also included. This creates a spreadsheet 
to keep a record of your students’ marks and for analysis. The spreadsheet lists each question with its 
ExamWizard reference, type of question, Specifi cation references, target level and the marks available.
To create a mark entry sheet follow these steps:

• Step 1

 Click on Tools, Create/Edit Student Lists.

• Step 2

 Enter your students’ details or import
 a fi le of student details saved in
 .csv format.

• Step 3

 Click on Tools on the main tool bar  
 and Create Mark Entry Sheet.
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• Step 4

 Click Yes to use the student list you  
 have created or No if not.

• Step 5

 Enter a name for your mark entry sheet  
 in the pop up window and press save  
 then a mark entry spreadsheet will
 be created as an Excel fi le.

Here is an example of a mark entry sheet created for a selection of questions:Here is an example of a mark entry sheet created for a selection of questions:

The spreadsheet itemises the selected questions, enabling mark entry and 
basic calculations (e.g. total marks, percentages and averages).

Ideas for activities and use
Peer Review

Students can do a test and then use the mark scheme to mark their own or other students’ work.   
This activity might be carried out in small groups where students can share insights and gain from   
the understanding of other students. Students can also start to identify their strengths and weaknesses
for themselves.

Save documents for year-on-year use or for sharing with colleagues who also use ExamWizard.
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Installation Requirements
To use ExamWizard, you will require the following: 

•	 A PC running Windows 98, NT4, 2000, ME, XP, Vista or Windows 7;
•	 266MHz PII processor;
•	 64 MB of memory (128 MB for Windows XP);
	 (ExamWizard will run on less but you may find some features slow)
•	 The amount of space needed will vary according to subject, and is noted during installation. 

	 We advise you to consider at least 500MB of free space on the hard drive.

ExamWizard is not supported on Mac computers

Running the ExamWizard demonstrations
To try an ExamWizard subject demonstration, go to the PRODUCTS & ORDERING page of the website 
http://examwizard.testbase.co.uk/sec/pindex.asp. Click on the name of the subject you wish to explore and 
install the demo by following the on-screen instructions. The full software for each subject is also available for 
download from the website. Downloads will require you to purchase an ExamWizard licence for each subject.

The ExamWizard licence and access to the full program 
You will need to buy an ExamWizard licence for each subject program you wish to use. The licence allows you 
and your colleagues to install the program on to any computer that is owned by the school or any computer 
used by a teacher working at the school (including at home). After you have received the licence code for a 
subject (we will send this by e-mail or post), go to the download page on the ExamWizard website 
http://examwizard.testbase.co.uk/sec/download.asp, click on the download button, enter the licence code 
and follow the instructions to install ExamWizard. Please make sure to enter the licence details carefully. 
Once ExamWizard is installed on your computer, you can run it either from the desktop icon or from 
the start menu.

FAQs 
Answers to frequently asked technical questions can be found on the ExamWizard website, where you can 
also submit a web query or comment in the SUPPORT PAGE of the website.

http://examwizard.testbase.co.uk/sec/support.asp
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APPENDIX 1

End of topic test

Copy selected 
questions to document

Browse questions

Click Continue Search

Choose a level

Click Start Search

Choose your topic

Do you want to
edit the document?

NO

NO

Do you want to
add another level?

YES

NO

Export to Word

YES

YES

YES
Do you want

a mark scheme?

Print

Create mark scheme
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APPENDIX 2

Type of questions

Example: Types, GCE Physics (8/9PH01)

Browse questions

Create mark scheme

Copy selected 
questions to document

Print

Click Start Search

Select type
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APPENDIX 3

Deconstructing the question

View examiner’s report

Browse questions

View mark scheme

Copy selected question 
to document

Print

Copy mark scheme
to document

Copy examiner’s report
to document

Click Start Search

Select topic or type


